
 
 

 
 

From the President  
 
 

Sprinters needed! 
  
Greetings KB'ers! 
   
The Sprint format has established itself as one of the 
most viable forms of "short format" contesting.   For 
those who find themselves time challenged or physically 
challenged operating more standard long format con-
testing, this is a great way to get on the air, and com-
pete, and still have time for that dinner with the XYL, (or 
OM), or sneak in during a work weekend. 
  
More about the sprints.. 
  
The NCCC has established itself as a leading club when it 
comes to the sprints.  We regularly foster teams that 
score very well in the NCJ sponsored events, and we as a 
club sponsor our own flavor of sprints, the NCCC sprint/
sprint ladder weekly cw event and its warm up, the slow 
NCCC sprint SNS both of which make up what is now 
called Thursday night contesting. At 30 minutes in 
length, you would be hard pressed not to find time for 
such an event. 
  
NCJ sponsors 6 sprints per year, Two CW, Two SSB and 
Two RTTY.  These events are Saturday events, and are 4 
hours in length.  They boast team registration, (in the 
form of teams of 10 operators each). The NCCC regularly 
fosters several teams, and of course has established it-
self amongst the top scoring team providers. 
  

 

Guests are always welcome at the NCCC! Please join us. 

 

Monday, September 12, 2011 
 

Program 

“2011 California QSO Party” - Rhino, N6RNO 
  

Date: Monday, 12th September 
Time: 6:00pm schmooze, 7:00pm dinner, 7:30pm program  

Location: China Wok 

512 Sacramento Street 

Vallejo, CA 94590 

Telephone  (707) 645-2008 

Directions: 

 http://tinyurl.com/2f892nb  

Issue 472 

September 2011 

Inside this issue: 

August Meeting                               5 

SO2V  by N6EE                               9 

CQP                                                   14 

Contest Calendar                            15 

http://tinyurl.com/2f892nb


Page 2  

Because the sprints have a QSY requirement, and a clearly defined etiquette when it comes to the QSO it-
self, many have found the format to be intimidating, both as operators, and to the amateur public in gen-
eral. But a little digging into rules and format, and you will find that these requirements are easy to master, 
and once you do, one needs only to focus on the experience and dedication needed to compete on a high-
er level, and subsequently have fun and enjoy the format. 
  
Challenges 
  
Some of the top CW operators embrace sprint, enjoy its fast pace and minimal time impact, so the CW fla-
vors of the sprint remain quite popular amongst the serious CW contester.  However, this popularity seems 
to be waning when it comes to SSB sprint.  Its ironic that the SSB sprint be less embraced currently, even 
though one would think that it is more accessible to all, (no need to know CW to do it).  But the fact is that 
the SSB sprint format at risk of disappearing due to lack participation.  One of the major aspects of this is 
one of them falls on the weekend of a major RTTY contest.  With its increased popularity, fast pace and 
ease of accessibility to all, many operators prefer to engage in the RTTY event, rather than the SSB 
event.  The culminating result of intimidation, contest choice and lack of understanding has had the unfor-
tunate result of threatening to put the SSB sprint out of business due to lack of participation.  I submit this 
as the challenge to the NCCC, let’s all get on the air for the SSB sprint, and put this back on the map. 
  
So what do we do? 
  
Well it’s simple- get on the air and sprint. If you don’t understand the format, get on the Internet, find the 
readily available documentation and training material, learn how to participate and get on the air.  We as a 
group should not let a contest die due to lack of participation, and I have all the confidence in the world 
that our great membership in the good ship NCCC can put the SSB sprint back on the map because if we 
show up and play, others will follow and try and challenge us. Let’s give them a good run for the money! 
  
Bottom line 
  
Get on the air for all the sprints!  Learn the format, become an expert.  Enjoy the fast pace, and embrace 
the skills you will learn with the format of contest that requires you to be one with your radio  (or one with 
2 radios if you really get good!).  Enjoy the fact that you can compete full bore, and still have time for din-
ner with your significant other. 
  
I hope to hear more of you on the air during all forms of sprint, but especially the SSB sprint.  Let’s not lose 
a contest, let’s restore it to greatness! 
  
73 es KB 
  
Chris 
N6WM 
El Presidente. 
 
 

 
 



Page 3  

VP/CC Corner  
 

 
Hello Fellow Contesters! 
 
Ready or not the contest season is here. Yee Haw! 
 
This month I want to share a tip for having more fun for little-pistol and middle-gun stations. 
 
Contesting can be lots of fun. Working stations makes contesting fun. If you’re not working stations, contesting isn’t 
fun. Contesting is a real drag if you’re banging your head against a brick wall.   
 
So here’s my tip. If you’re signal challenged, try Running more and S&Ping less. 
 
I know, I know. Conventional wisdom says signal-challenged hams should start out a contest doing mostly S&P and 
switch to Run later in the contest.  
 
I suggest just the opposite. Here’s why. 
 
When you call stations, you are competing against all the other stations that might be calling. If your signal is rela-
tively weak, you’re going to lose out to stronger calling stations.  Early in a contest, many people are following con-
ventional wisdom and S&Ping. There’s too much S&P competition early in a contest.  
 
When you CQ, your only competition is signal-to-noise ratio. The trick is to find a decent frequency to CQ on. My ex-
perience says very low or high in the band. Pick what sounds like a clear frequency. Call CQ. If you don’t get contacts, 
it means you’re frequency isn’t so good—perhaps too many loud stations close to you. Pick another frequency and 
try again. You’ll learn to pick good CQ frequencies. You’ll also learn that as a signal-challenged station, you’re not 
going to win frequency fights—don’t waste time, just move.   
 
Later in a contest is the time to S&P for the signal-challenged ham. You’ll find much less competition when calling 
stations. And, all the signal-challenged stations following conventional wisdom are CQing and just begging for you to 
call them.  
 
I understand that my tip runs counter to conventional wisdom. My tip is not black and white. You have to adjust and 
adapt throughout a contest. But, if you’re signal-challenged, and if you want to have more fun in a contest, consider 
more Running early and S&Ping later. Try it and see if it works for you.  
 
 
The first rule of contesting is to have fun—Contest Exuberantly! 
 
73, 
 
Hank, W6SX 
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Officers:               

President      Chris Tate  N6WM   ctate@ewnetinc.com  

Vice President    Hank Garretson  W6SX  w6sx@arrl.net  

Secretary/Treasure Tom Hutton  N3ZZ  nccc.n3zztreasurer@gmail.com  

 

Past President   Jack Brindle  W6FB  jackbrindle@earthlink.net  

Director     Kevin Rowett  K6TD  kevin@rowett.org  

Director  John Miller  K6MM  k6mm@arrl.net 

Director    Bob Vallio  W6RGG rbvallio@gmail.com 

Volunteers: 
New Member Mentor Al Rendon  WT6K  wt6k@arrl.net    

Founding Father  Rusty Epps  W6OAT  w6oat@sbcglobal.net 

Awards Chair  Kevin Gehrke  KG6D  kg6d@comcast.net  

CQP Chair  Rick Eversole  N6RNO  rick@eversoles.com 

CQP Certificates  Andy Faber  AE6Y  ae6y@arrl.net 

K6ZM QSL Manager George Daughters  K6GT  k6gt@arrl.net 

K6CQP,N6CQP,W6CQP QSL Mgr Ed Muns   W0YK  w0yk@msn.com 

NCCC Email reflector Admin Phil Verinsky  W6PK  kb-w6tqg@verinsky.com 

Webmaster Chair  Dean Wood  N6DE  cqden6de@gmail.com 

Webmaster  John Miller  K6MM  k6mm@arrl.net 

JUG Editors  Ian Parker  W6TCP  w6tcpian@gmail.com 

  Stu Phillips  K6TU  stu@ridgelift.com 

 NCCC Membership Information 

If you wish to join NCCC, you must  fill out an application for membership, which will be 
read and voted upon at the next monthly meeting. (PDF application form) 

To join, you must reside within club territory which is defined as the maximum of: 

 Northern California, anything north of the Tehachapi's up to the Oregon border, and 

 A part of north-western Nevada (anything within our ARRL 175-mile radius circle cen-
tered at 10 miles North of Auburn on Highway 49). 

 

Thursday Night Contesting: 
NCCC—Sprint   Ken Keeler  N6RO   kenkeeler@jazznut.com 

NS Ladder  Bill Haddon  N6ZFO  haddon.bill@gmail.com 

Slow NS (SNS)  Chris Tate  N6WM  ctate@ewnetinc.com 

NCCC Net 

Thursday 8 PM  

3610+/-  

NCCC  

Monthly meetings 

take place on  the 

second Monday of 

each month ! 

 

Details here  

http://nccc.cc/application.html
http://nccc.cc/pdf/application-n3zz.pdf
http://nccc.cc/images/nccc_territory_6_oct_2005.PNG
http://nccc.cc/meetings.html
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August 2011 – Meeting in Livermore, CA 
 
The summer doldrums and family commitments didn’t stop an appreciative group of NCCC members 
meeting at the Cattlemens in Livermore to enjoy a good schmooze session and some hearty cuisine! 

 
NCCC President Chris N6WM called the meeting to order for a packed session of 
presentations and kicked off the proceedings by distributing NCCC 40th anniver-
sary sweepstakes tee shirts to those who qualified and were present at the 
meeting. 
 
If you qualified for one of the tee shirts and haven’t received it yet, please drop 
Chris an email. 
 
Chris then handed over to John K6MM for a presentation covering “Post Contest 
Log Analyzers”.   
 
 

John gave a great presentation showing how to use a number of different analyzers to post process Cabrillo 
log files.  A couple of the analyzers covered included CBS and SH5. 
 
CSB (Cabrillo Statistics) was originally written by K5KA (SK) and is now 
maintained by NCCC member Bob N6TV.  CBS is a command line utility 
that runs on Windows and Macs to product a set of reports that are more 
detailed than those typically produced by logging programs such as 
N1MM or Writelog.  You can download CBS from the following web site: 
http://www.kkn.net/~n6tv/cbs - click the link to visit Bob’s CBS page. 
 
John gave live demonstrations on CBS and SH5 – SH5 generates a com-
prehensive set of reports that can be viewed with a standard web brows-
er.  The reports are in graphical and tabular form and present a wide 
range of different stats to let you look back on how the contest unfolded 
score wise.  SH5 is also available on the Internet and can be found at: 
http://www.tr4w.com/sh5/.  
 
 
 
A highlight of John’s presentation was a comparison of a number of NCCC member logs from the NAQP 
RTTY contest a few weeks ago.  John compared logs from similarly equipped stations and showed that one 
of the key differences that affected the scores was the strategy/choice of the two hour “off” period re-
quired by the NAQP rules.   
 
Its worth thinking about comparing your logs to those of other similarly equipped stations when thinking 
about how to maximize your score or thinking about beating last year’s performance in a given contest. 
 
 
 

http://www.kkn.net/~n6tv/cbs
http://www.tr4w.com/sh5/
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Next up was Rick N6RNO with a presentation on the upcoming California QSO Party 
which has its 45th running this year over the weekend of October 1st and 2nd.  Its not 
too late to plan a rare county “CApedition” and there are still a number of counties 
that need serious activation.  Please visit the CQP web site at http://www.cqp.org 
for the full rules and the county activation signup form. 
 
 
As you know, NCCC sponsors the CA QSO Party – Rick N6RNO is the CQP Chairman is 
aided and abetted by the NCCC “Green” team who handle the promotion, log analy-
sis and awards process. 
 
The final presentation of the evening was again by John K6MM describing the (then) upcoming CW Ops 
Open contest that was held over the weekend of August 21st.   
 
Thanks for all who attended the meeting and a very special thanks to John K6MM and “Rhino” N6RNO for 
their presentations! 
 
 

Rooftop antenna party gets ND2T back on the air! 
 
Tom ND2T’s SteppIR was down for the count after almost 8 years of service.  The antenna had bad SWR on 
all bands and the factory-assisted diagnosis was that most likely one of the motor units (the “EHU”) con-
trolling the element length wasn’t working correctly. 
 
Answering Tom’s call for help were Kevin K6TD, Dean N6DE, Rebar N6DB and Stu K6TU – who all converged 
on Tom’s QTH in Palo Alto one reasonably cool Sunday morning in early August. 
 
Dean and Rebar made up the climbing crew and efficiently disconnected the antenna from the mast plate 
enabling the antenna to be lowered onto the flat part of the roof.  Stu had brought along a metal detector 
(used for keeping metal bits cleaned up in the horse corral at his 
Woodside QTH) to see which element was defective but visual inspec-
tion was sufficient – one side of the driven element had copper tape 
hanging out of the end of the fiberglass tube! 
 
Kevin K6TD had a serious look at the EHU once it was removed from 
the antenna and quickly concluded that it was not field repairable – 
back to the factory for the failed unit and a replacement required. 
 
Murphy EI9GOTCHA was also present at the antenna party and of 
course the spare EHU Tom had received from the factory was for a 
passive element, not the driven element!  Rebar put a quick call into 
Larry W4UAT who confirmed that he still had a driven element EHU 
on hand from his own recent repair.  A quick conversation between 
Tom and Larry had each of them heading for a rendezvous mid-way 
between their two QTHs at the tollbooth of the San Mateo Bridge. 
 

http://www.cqp.org
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With Tom mobile en-route, the rest of the crew set 
about checking the rest of the antenna and performing 
some basic maintenance including replacing the foam 
plugs in the end of several of the tubes. 
 
Despite 8 years of UV exposure and some visible surface 
deterioration, the fiberglass tubes retained their me-
chanical integrity with a little paint loss – visible in the 
picture above. 
 
Once Tom returned with the driven EHU, the antenna 
was quickly put back in working order and an operating 
test run before hoisting the antenna back up on the 

tower.  Dean and Rebar climbed back up the tower and the antenna was hoisted up, bolted back on the 
mast plate to complete the job. 
 
With the antenna back on the tower and fully functional, Tom was back on the air and made a QSO with 
ST0R to celebrate!  This was a great example of NCCC teamwork with focus on safety and efficiency to help 
complete a job that would have been ugly or impossible for a smaller number of people. 
 
 

WRTC 2014 gets 501 (c) 3 status 
 
 
 
 
 
 
Late breaking news from Rusty W6OAT – WRTC 2014 issued press release a few days ago that they had re-
ceived 501(c)(3) status from the IRS… 
 
From the WRTC press release… 
 
WRTC2014, Inc., host of the 2014 World Radiosport Team Championship competition is pleased 
to announce that it has received a Letter of Determination from the U.S. Internal Revenue Service 
granting 501(c)(3) status as a tax-exempt public charity. This means that contributions to 
WRTC2014, Inc. by U.S. taxpayers are deductible to the extent allowed by law. 
 

NCCC members have so far sponsored three of the tents for the 2014 running of the WRTC.  If you would 
still like to make a contribution on behalf of NCCC, you can now make that donation directly to WRTC-2014 
with a note advising of the attribution to NCCC at http://wrtc2014.org/. 
 
 
 
 
 

http://wrtc2014.org/
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New Product Review – Metcal MX-5010 Soldering Station 
 
Keeping a modern contest station going and im-
proving is an endless task.  Whether its routine 
maintenance or building new equipment there’s 
always something to have to solder.  If you are 
like me and have to contend with everything 
from soldering surface mount parts to coax con-
nectors, you probably have a number of different 
soldering tools on hand. 
 
Recently, my faithful Weller TCP-1 gave up the 
ghost after 30 years of service.  I was in the mar-
ket for a new soldering solution that would give 
me power and flexibility.  Although not inexpen-
sive, I zeroed in on the Metcal MX series from OK 
International thanks to some excellent advice 
from Kevin K6TD.  The Metcal uses plug-in tip 
cartridges that are available in a wide range of 
different power, size and shape formats.   
 
The Metcal uses RF energy to drive a heater that is mounted right at the tip of the cartridge – this gives 
precise power control and almost instant “on” operation. 
 
Purchasing a Metcal new is a daunting proposition as they are intended for electronic assembly houses and 
are quite expensive.  Fortunately you can find a variety of new and used Metcal stations on EBay.  With 
some judicious bidding and a regular eye on the auctions, you can pick a Metcal up starting at around $300. 
 
Don’t buy used cartridges!  Its false economy and the cartridge tips are about $22 new – available ex-stock 
from Mouser or other distributors. 
 
The Metcal delivers enough power in a concentrated area that a 5 mm shovel tip will easily solder a PL-259 
connector.  Put in a 1 mm chisel tip with a bend and you can handle the smallest surface mount part sol-
dering jobs even if you need a microscope to see the part! 
 
The Metcal is simply the finest soldering tool you can find – with a proven track record for robustness and 
reliability, I may have purchased my last soldering tool! 
 
Stu Phillips – K6TU 
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SO2V: Exploit Your Subreceiver 
 

Ron Lodewyck, N6EE 

 

Recently, RTTY guru Ed Muns, W0YK, told me about an exciting new feature added to Writelog which takes ad-

vantage of the Elecraft K3 independent subreceiver to emulate SO2R (Single Op 2 Radio).  He called it SO2V (Single 

Op 2 VFO).  SO2V is not as flexible or efficient as SO2R contesting, but it does have the potential to increase operator 

productivity, i.e. increase your contest score, as well as increase the fun.  While this article describes the SO2V con-

cept using an Elecraft K3 transceiver, it probably will work with other radios as well.  The concept is not really limited 

to RTTY; it should work for CW and phone as well. 

 

Here’s  how it works: 

 

Recent versions of Writelog have the ability to select two radio operation with both radios on the same com port.   

This creates two entry windows: one for VFO A (main receiver) and one for VFO B (subreceiver).  With the focus in 

VFO A Entry Window you open a RTTY window (call it RTTY Window A) which will be used to enter and transmit data 

via VFO A.  Similarly, with the focus in VFO B Entry Window you open a second RTTY window (call it RTTY Window B) 

which will be used to enter and transmit data via VFO B (actually SPLIT mode).  Now you have two RTTY windows on 

the screen, each with its own tuning indicator as seen in the accompanying screen capture image. 

 

With the K3 subreceiver turned on, VFO B tuning shows up in RTTY Window B and VFO A tuning shows up in RTTY 

Window A.  If you click on a callsign displayed in RTTY Window A, that data is transferred to Entry Window A; if you 

then send the exchange programmed message, the K3 transmits on the VFO A frequency.  Similarly, if you click on a 

callsign displayed in RTTY Window B, that data is transferred to Entry Window B; if you then send the exchange pro-

grammed message, the K3 transmits on the VFO B frequency.  You can see this correlation in the accompanying 

screen capture image: clicking on W3BGN in RTTY Window A puts W3BGN in Entry Window A; clicking on VE3CRG in 

RTTY Window B puts VE3CRG in Entry Window B.   

 

This setup allows several operating advantages: 

 

Search and Pounce 

 

If you set VFO A to one end of the RTTY subband and VFO B to the other end of the RTTY subband, you can tune both 

VFOs simultaneously while looking for your next QSO.  I like to tune VFO A down from the top of the subband and 

simultaneously tune VFO B up from the bottom of the subband.  I stop tuning the VFO which first finds a station and 

continue tuning the other VFO until I have a second station tuned in.  This is actually quite easy to do with RTTY since 

it is just a matter of watching the tuning indicator; I like to use three tuning indicators in each RTTY Window: Spec-

trum (tune for aligned twin peaks), XY scope (tune for vertical & horizontal ellipses), and Waterfall (tune for trace 

alignment).   I initiate a QSO in whichever window is QRZ first.  When I finish the first QSO I wait until the second win-

dow is QRZ and complete that QSO.  But I have also started tuning in the first window, looking for the next QSO.  I 
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resume tuning both VFOs simultaneously as soon as the second VFO QSO is completed.  While this may sound com-

plicated, it really isn’t; tuning both VFOs simultaneously is smooth and natural and watching the tuning indicators is 

straightforward. 

 

Finding Mults While CQing 

 

Let’s say you are CQing on your VFO A frequency.  You can be simultaneously tuning for signals on the subreceiver 

whenever you are not transmitting.  When you find a new station on the subreceiver, you watch until the timing is 

synchronized with your CQing, click on the new callsign in RTTY Window B, and initiate a QSO.  While this is happen-

ing, you may very well see that you have a station responding to your CQ in RTTY Window A.  As soon as the QSO is 

completed in RTTY Window B, you click on the callsign, if any, in RTTY Window A and initiate that QSO.  IF no one has 

responded to your CQ, you would click in the Entry Window A (or press the Up Arrow key) and resume your CQing 

routine.   

 

Find a good CQ frequency 

 

Actually, it is not necessary to CQ on VFO A and Search on VFO B – you can just as easily CQ on VFO B and Search on 

VFO A.  You can improve efficiency while searching for a good CQ frequency.  You follow the Search and Pounce pro-

cedure as described previously; if you come upon a clear spot in either VFO you just select the associated Entry Win-

dow and start your CQ routine. 

 

Setup the K3 

 

The Elecraft K3 needs to have a subreceiver installed and turned on – tap the SUB button to turn it on.  Tune both 

VFOs to TX DATA on the same band.   

 

Setup MMTTY 

 

Assuming you use the MMTTY plugin for RTTY, you need to install two copies in separate folders.  Setup copy one 

(call it MMTTY1) with the Soundcard set to the Left channel so that this copy of MMTTY will display VFO A signals.  

Setup the soundcard on the second copy of MMTTY (call it MMTTY2) to the Right channel so that the second MMTTY 

displays signals received on the subreceiver.  Of course, you need to use a standard stereo cable from your sound-

card LINE IN to the K3 LINE OUT. 

 

Assuming you use FSK RTTY, you will need two COM ports.  Setup MMTTY1 to use FSK on an available COM port and 

MMTTY2 to use FSK on a different and available COM port.  The two FSK keying circuits are wired in parallel to the K3 

ACC-1 FSK IN pin.  I use a breakout adapter connected to the K3 ACC-1 DB15 connector to facilitate easy wiring. (This 

adapter is available from Winford Engineering as BRKSD15M-C http://www.winfordeng.com/products/brksd15.php ). 

 

 

http://www.winfordeng.com/products/brksd15.php
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Setup Writelog 

 

In Writelog you will need to do the following: 

 

1. In Setup -> Ports you need to have two radios configured for rig control.  Create a second Rig Type (i.e. another 

row in the table) to Elecraft K3 and select the same COM port (call it COMM x) that the first K3 row uses for rig 

control.  Both radios should also be set to the K3 baud rate (usually 38400). 

2. Since this discussion assumes RTTY, in Setup -> Ports, be sure you have not selected CW, Rotator, or SO2R con-

trols to use either of the two FSK COM ports. 

3. From the Menu: Radio -> Number of Radios , select “2”. 

4. From the Menu: Radio -> Headphones Split (so you don’t mute the non-focus audio). 

5. In Entry Window A (upper) click the Frequency/Mode button (the one that displays the rig frequency and mode) 

to display the drop down selection box “Log the frequency of QSOs”.  Select “rig on COMMx”, where x corre-

sponds to the COMM port used for the K3 rig control. 

6. Similarly, In Entry Window B (lower) click the Frequency/Mode button (the one that displays the rig frequency 

and mode) to display the drop down selection box “Log the frequency of QSOs”.  Select “rig(2) on COMMx”, 

where x corresponds to the COMM port used for the K3 rig control. 

7. With the focus in Entry Window A, select from the Menu: Window -> RTTY.  If you have never opened a RTTY 

window before this, select  TU Type -> MMTTY.  You will be prompted to Browse for the MMTTY.EXE file corre-

sponding to MMTTY1.  If you have previously configured Writelog to use MMTTY1 for RTTY, it will open.  At this 

point you should have one MMTTY RTTY window with its associated tuning window displayed. 

8. Similarly, with the focus in Entry Window B, select from the Menu: Window -> RTTY.  Assuming you have never 

opened a second MMTTY RTTY window before this, select  TU Type -> MMTTY.  You will be prompted to Browse 

for the MMTTY.EXE file corresponding to MMTTY2, i.e. the second installed copy of MMTTY.  At this point you 

should have two MMTTY RTTY windows with their associated tuning windows displayed. 

 

Testing 

 

Verify that that you can tune in RTTY signals with VFO A (the  Main receiver) in RTTY Window A and RTTY signals in-

dependently with VFO B (the subreceiver) in RTTY Window B. 

 

For testing purposes, put the K3 in TEST mode (press and hold the MODE^/TEST button) or use a dummy load.   

 

With the focus in Entry Window A, type Alt-K to enable sending from the keyboard.  You should immediately hear 

the K3 “diddling” (you may need to increase the MON level).  Press the ESC key to terminate the diddling.  If you hear 

just a steady tone, you may need to check the settings in MMTTY1.  You can either do this from within Writelog or 

shut down Writelog and open MMTTY1 independently.   Also, check your FSK interface wiring.  If the K3 doesn’t go 

into transmit mode, check your Rig control settings in Writelog. 
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Similarly, with the focus in Entry Window B, Alt-K should produce “diddles”.  If not, check the configuration of 

MMTTY2. 

 

Other Possibilities 

 

I see no reason why the SO2V concept wouldn’t work on CW or phone.  I haven’t tried this because, quite frankly, my 

brain can’t handle the decoding in separate ears.  Maybe yours can – give it a try! 

I also believe the SO2V concept will work with AFSK RTTY.  Again, I haven’t even attempted this as I strongly prefer 

FSK. 

 

Finally, I believe the SO2V concept will probably work with any transceiver which can receive simultaneously on two 

independent  VFOs.  Radios like the Flex 5000, ICOM IC-7800, ICOM IC-9100, TenTec Orion II,  Yaesu FTDX9000, Yaesu 

FTDX5000, and Yaesu FT2000 (?) have dual receive capabilities which will probably work in the SO2V mode using 

Writelog.  If you own a radio with two independent receivers the SO2V concept is surely worth exploring. 

 

Limitations 

 

I would love to be able to have the subreceiver on a different band so that I could be working two bands simultane-

ously.  The K3 subreceiver can be set to a different band from the main receiver if CONFIG:Sub is set to IND.  Howev-

er, even with this configuration I was unable to get Writelog and the K3 to work together properly.  VFO B (the subre-

ceiver) would transmit for a second and terminate.  I never could get this to work.  I suspect it has to do with antenna 

selection for the subreceiver, but I haven’t looked into this sufficiently.  Any ideas? 

 

Experience 

 

I used this technique for the first time in the July 2011 NAQP RTTY contest and achieved my best score ever in this 

contest. In July 2010, my previous best score was 426 QSOs x 123 Multipliers for 52,398 total points.  In July 2011, 

using SO2V, my score was 465 QSOs x 135 Multipliers for 62,775 total points.  This indicates a nice improvement in 

QSOs, but also a dramatic improvement in multipliers.  The equipment was identical both years: K3 to a DB18E Step-

pIR at 48 feet plus an 80M Inverted Vee.  I attribute the increase in multipliers almost entirely to using the SO2V 

technique since I was unable to move multipliers to other bands due to the relatively slow retuning required by the 

SteppIR.  Needless to say, I intend to use SO2V in future contests.   

 

Conclusion 

 

This article has described a technique for using Writelog with an Elecraft K3 to approximate SO2R using the subre-

ceiver in the K3 and relatively new capabilities in Writelog.  This technique has the potential to increase your contest 

score while having more fun doing it. 
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October 1-2, 2011 
1600 UTC Oct 1 to 2200 UTC Oct 2  

The California QSO Party (CQP) is the premier state QSO party held every year on the first week-
end of October.  The Northern California Contest Club (NCCC) has sponsored CQP since 
1974.  CQP has traditionally opened the annual contest season by providing an opportunity for 
contesters to prepare for the ARRL November Sweepstakes since the format is similar. 

Stations outside of California, worldwide, work stations in California only. The 58 counties of CA 
are the multipliers.  California stations work all stations in or out of CA. The 50 US states and 8 Ca-
nadian provinces are the multipliers.  Stations outside of Canada and the US add to one's QSO total 
but do not count as multipliers. See the full set of CQP Rules for more details. 

On this site you will find lots of information, so peruse the index above and learn all about the Cali-
fornia QSO Party!  Also, be sure to visit the NCCC website for the latest scoop on a super contest 
club. 

 Before CQP:  
 Sign-up for the 2011 CQP (Sign ups will be accepted beginning around August 1st, 2011). 

 Read The 2011 Rules 

 Read CQP Operating Strategy, by K6RB 
 

 After CQP  

 Submit your log no later than Monday, October 31, 2011 

 The preferred method is to use the web server for submitting your contest log.  Go to this 
 URL and follow the instructions: logs.cqp.org 

 After you submit your log, you can check to be sure it's listed on the CQP server here: 
 http://cqplogs.appspot.com/claimed.jsp 

 T-Shirts - Like the wine, each year’s T-shirt is a special vintage.  For 2011 the color is 
 Brown.  Place your order for a T-shirt by sending an email to info@cqp.org stating the sizes 
 and quantities for each size (M/L/XL/XXL/XXL), the call sign of the CQP operation, the 
 call sign of the person placing the order, and the address to ship to.  All orders are due by 
 January 15th.  T-Shirts will ship in March.  Send payment, $15 ($20 for DX entries), either 
 via PayPal to paypal@nccc.cc, or a check to NCCC, 3572 Amherst Court, Mountain View CA 
 94040. 
 

Many NCCCers contribute to making the CQP a suc-
cess.   

Questions?  Visit the NCCC website here. 

Planning on operating in CQP ? 

 

Sent your CQP activity reports 

and pictures to the JUG editors!  

 

http://www.nccc.cc
http://www.cqp.org/cqp_multipliers.html
http://www.cqp.org/Rules.html
http://www.nccc.cc
http://www.cqp.org/Rules.html
http://www.cqp.org/pdf/cqp_strategy_k6rb.pdf
http://cqplogs.appspot.com/upload.jsp
http://cqplogs.appspot.com/claimed.jsp
mailto:info@cqp.org
mailto:paypal@nccc.cc
http://www.cqp.org/index.html
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Contest Calendar—September page 1 

QRP Fox Hunt 0100Z-0230Z, Sep 2 

NCCC Sprint Ladder 0230Z-0300Z, Sep 2 

International G3ZQS Memorial Straight Key Contest 2300Z, Sep 2 to 2300Z, Sep 4 

Russian RTTY WW Contest 0000Z-2400Z, Sep 3 

All Asian DX Contest, Phone 0000Z, Sep 3 to 2400Z, Sep 4 

Wake-Up QRP Sprint 0600Z-0629Z, Sep 3 and 

  0630Z-0659Z, Sep 3 and 

 0700Z-0729Z, Sep 3 and 

 0730Z-0800Z, Sep 3 

Brazil Independence Day BPSK31 CDX Contest 1200Z, Sep 3 to 1200Z, Sep 4 

Colorado QSO Party 1200Z, Sep 3 to 0400Z, Sep 4 

IARU Region 1 Field Day, SSB 1300Z, Sep 3 to 1259Z, Sep 4 

AGCW Straight Key Party 1300Z-1600Z, Sep 3 

RSGB SSB Field Day 1300Z, Sep 3 to 1300Z, Sep 4 

CWops Mini-CWT Test 1300Z-1400Z, Sep 3 and 

 1900Z-2000Z, Sep 3 and 

 0300Z-0400Z, Sep 4 

QCWA Fall QSO Party 1800Z, Sep 3 to 1800Z, Sep 4 

DARC 10-Meter Digital Contest 1100Z-1700Z, Sep 4 

Tennessee QSO Party 1800Z, Sep 4 to 0300Z, Sep 5 

MI QRP Labor Day CW Sprint 2300Z, Sep 5 to 0300Z, Sep 6 

ARS Spartan Sprint 0100Z-0300Z, Sep 6 

FISTS Get Your Feet Wet Weekend 0000Z, Sep 9 to 2400Z, Sep 11 

QRP Fox Hunt 0100Z-0230Z, Sep 9 
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Contest Calendar—September page 2 

NCCC Sprint Ladder 0230Z-0300Z, Sep 9 

PODXS 070 Club Jay Hudak Memorial 80m Sprint 2000 local, Sep 9 to 0200 local, Sep 10 

Kulikovo Polye Contest 0000Z-2359Z, Sep 10 

WAE DX Contest, SSB 0000Z, Sep 10 to 2359Z, Sep 11 

Arkansas QSO Party 1300Z, Sep 10 to 0100Z, Sep 11 

Ohio State Parks on the Air 1600Z-2400Z, Sep 10 

ARCI VHF Contest 1800Z, Sep 10 to 0300Z, Sep 12 

ARRL September VHF QSO Party 1800Z, Sep 10 to 0300Z, Sep 12 

North American Sprint, CW 0000Z-0400Z, Sep 11 

SKCC Weekend Sprint 0000Z-2400Z, Sep 11 

Swiss HTC QRP Sprint 1300Z-1900Z, Sep 11 

NAQCC-EU Monthly Sprint 1800Z-2000Z, Sep 12 

CWops Mini-CWT Test 1300Z-1400Z, Sep 14 and 

 1900Z-2000Z, Sep 14 and 

 0300Z-0400Z, Sep 15 

RSGB 80m Club Sprint, SSB 1900Z-2030Z, Sep 14 

NCCC Sprint Ladder 0230Z-0300Z, Sep 16 

AGB NEMIGA Contest 2100Z-2400Z, Sep 16 

Connecticut QSO Party 0000Z-2359Z, Sep 17 

ARRL 10 GHz and Up Contest 0600 local, Sep 17 to 2400 local, Sep 18 

SARL VHF/UHF Analogue/Digital Contest 1000Z, Sep 17 to 1000Z, Sep 18 

CIS DX QPSK63 Contest 1200Z, Sep 17 to 1200Z, Sep 18 

Scandinavian Activity Contest, CW 1200Z, Sep 17 to 1200Z, Sep 18 

South Carolina QSO Party 1300Z, Sep 17 to 2100Z, Sep 18 
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Contest Calendar—September page 3 

SRT HF Contest SSB 1300Z, Sep 17 to 1300Z, Sep 18 

QRP Afield 1500Z, Sep 17 to 0300Z, Sep 18 

Washington State Salmon Run 1600Z, Sep 17 to 0700Z, Sep 18 and 

 1600Z-2400Z, Sep 18 

Feld Hell Sprint 1600Z-1800Z, Sep 17 

North American Sprint, SSB 0000Z-0400Z, Sep 18 

WAB 144 MHz QRP Phone 1000Z-1400Z, Sep 18 

BARTG Sprint 75 1700Z-2100Z, Sep 18 

Run for the Bacon QRP Contest 0100Z-0300Z, Sep 19 

144 MHz Fall Sprint 1900 local - 2300 local, Sep 19 

NAQCC Straight Key/Bug Sprint 0030Z-0230Z, Sep 22 

NCCC Sprint Ladder 0230Z-0300Z, Sep 23 

ARRL EME Contest 0000Z, Sep 24 to 2359Z, Sep 25 

CQ Worldwide DX Contest, RTTY 0000Z, Sep 24 to 2400Z, Sep 25 

Texas QSO Party 1400Z, Sep 24 to 0200Z, Sep 25 and 

 1400Z-2000Z, Sep 25 

AGCW VHF/UHF Contest 1400Z-1659Z, Sep 24 (144) and 

 1700Z-1759Z, Sep 24 (432) 

UBA ON Contest, 6m 0600Z-1000Z, Sep 25 

QRP Homebrewer Sprint 0000Z-0400Z, Sep 26 

222 MHz Fall Sprint 1900 local - 2300 local, Sep 27 

SKCC Sprint 0000Z-0200Z, Sep 28 

CWops Mini-CWT Test 1300Z-1400Z, Sep 28 and 

 1900Z-2000Z, Sep 28 and 

 0300Z-0400Z, Sep 29 

RSGB 80m Club Sprint, CW 1900Z-2030Z, Sep 29 



 

 

 
 

 

 

Please consider writing an article for JUG ! 

 September Newsletter Deadline—September 28th 
This is your newsletter so lets make it something we are proud of.  I hope you will consider writing 

an article for the JUG! Whether its about your station, recent contest experience or a technical arti-

cle we would appreciate hearing from you.  

 

Send your articles to  Ian W6TCP w6tcp@comcast.net and Stu K6TU stu@ridgelift.com 

 

 

mailto:w6tcp@comcast.net
mailto:stu@ridgelift.com

